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Tl BRI AR - EI R R IR LL SAS ~ SPSS ~ STATA
R EMHBAAEATR - BiF A SRS ERAE - 1R GERHE et
ZAETURF - ANMATIH AR 2 TR R - 22K HEREIARTE - Matikaets =
PRI - R T A HIRE T SR BE PO E A S E HTHRESD - Stat/Transfer 255
i H BRI AR ZA% SR TR - ASOREE T 2SR AHE A JME i ThRE > Ty —
FT AT SR ER I LA R B R T AR R 2 5 B8 R0 AR AL s
AR A B i P Y BB R S B EXCEL A > Y LU SAS 9.2 i)t ~ SPSS 20
i~ STATA 12.1 a8 73t - Stat/Transfer iz T B e S $7 rm hRe ik
TEEET TR -

=~ EAN/EHRETERIEERETIAE

TEAERAANRTEAR R - SERR AR L = R R 2= 2 (3% 1) » Hirfr SPSS ~
STATA BRI R] DI &3 T8RP (variable label ) EHSETEEL{EEREA (value label) [
# 0 {H SAS ERMEE M S - EEBERR RS S DU SRS - TEM

format 554 REHLTT «

21 : SAS - SPSS ~ STATA &kl 7 5

L/ Gi-
SAS SPSS STATA
=M
s B AR AR | B EE T | EREE T
(Gae3 TEFfEZEH TEFIfEZEH
ERHE * sas7bdat
* sav * dta
F A * sas7bcat

PR ERHASZ RIS TR RS BRI SR MERIRIRE - SR DI A > FEBCRE TR
(syntax ) BEEETTHE AN - FEE AR AE B PR ~ 08T A 5 ]
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(—) SAS BRESNE A R FEH! SPSS/STATA i
1~ REZEMEA ([EPREL SPSS ZORHE Ryl

FHTHSZ MEZE > MEAZFR > ERGEN SPSS B STATA BRI
B

What twpe of data do vou wizh to import?

D i = Select a data source froom the list below .
= FRAER D). SPES File (% sav) v
ERBAC) Microsoft Exeel Q7200020022002 Warkbook
[\t icrosoft Excel 5 or 95 Workbook (* 3z
BN (E) Microzoft Excel 4 Spreadshest (* xdsz)
Microsoft Access 2000/2002/2003 Databage
A R (D)... Microsoft Access 97 Database
SR B
ab Delirte bt
i Dees Fl
LT L) :
w TMF File {*jmp)
S EEED. Lotus 1-2-3 Spreadsheet (* k1)
Lotuz 1-2-3 Bpreadsheet (*awl3)
2 BT e 4
& EEHEEER) . K Fﬂﬂ{* djl
Paradox File {*.db)

R TEERAEHOR SAS WORK library 51 » SlfifA Member HETHE Z 447 »
£ Finish Z2RAITTRARZME A DR st EER I B I S ERR B -
—{FME A Z SAS Formats £

Chooze the 345 destination:
Libraryr:
WORE W

Help | Cancel | < Back | Next= | Finish
FRIZEHERLESS - IRTHHREREEIUE S » SBEiE 2B T

"bﬁééii\hﬁéﬁéﬁ’)ﬂf”v{/’c}ﬁk’s’r’dai ”””””””””””””””””””””””””””””
DATAFILE= "c:\srda.sav"
DBMS=SAV REPLACE;




2~ REZEMEH ([BPREL SPSS ERMAE Rl )

FHTHYE TR > MEHER > ELRGEL SPSS B STATA &R
A SRS § #5H SAS Formats 1 - HABIERIA BRI IERY] - thly
—DHHEH -

TWhat type of data do you wish to export?
FRERE) WO Standard data source

[ #rigfz=an Select a data source from the list below,
= RO, SPSS File (* sav) v
ERPALC) Minromit Excel 0772000/2002/2003 Workbook
[ ticrosnt Excel 5 or 95 Workbook (¥ =z
FEANED... Microanft Excel 4 Spread sheet (*.3ds)
Microsoft Access 200020022003 Databaze
ﬁ RAREAD... Microsoft Access 97 Databaze
Comma Beparated Values (% cav)
H&#F Tahb Delimited File (% tef)
Delimdted File (* %)
SETFHETE L. dBARE File (*dbf)
TMF File (* jimp)
i SFIHRE).. Lotus 1-3-3 Spreadsheet (% wkl)
. Lotus 1-2-3 Spread sheet (* w3l
o BEAEEND ... Lo 35
KT Fﬂg % ta)
Paradox File (*dh)

FEAE E A B ] 3 Create SAS statements fEHURAE = GE T DUEF%
TR TR -

The export Wizard can create a file containing PROC EXPORT statements
that can be need in SAS programs fo export this data again.

If 2o want thess statements fo be generated, enter the filename where
thexr should be saved:

|C:".ex1:n:|rt.sas

[ ] Eeplace file if it excists.

Help | Concel : Back Finish

HRESHUR
"|5'ré<'56 EXPORT DATA= WORK.srda =
OUTFILE= "c:\srda.sav"
DBMS=SAV REPLACE;




(=) SPSS #kBEpE A K MEH SAS/STATA &g
1 FEEMEA ([EZREL STATA ERHE R H1)
HTHEYZ TR > B > &F -

i k&S] [FEE0] - IBM SPSS Statistics Data Editor
WwWEE) fREE WwE0 BEED E@| oSfd JEtEG S

BEET v | B ;ﬁ %

R P ERE

RIRFEIEE) b D EEG.
(=) BRI FEEHD)... B B (0.
(o 2 2t C)..

B EEEAY SAS 5, STATA & RHE g% = Bl

BREW: [sroacta | mmo |
WEBA | Stats rdta) -

o

o

Excel (*xls, *xlsx, *xlsm) = Eaji
LR S Lotus (™ w™)

Syl (7.5l )

dBase {*.dbf

SAS FsasThdat® sd7 F5d2 Fssd1 Fssdld *uph
Stata *.dta)

ATEE (et *ddat s Ty

EREEE -

TR EIR SAS &rtE (.sas7bdat) EdA% = (.sas7bcat) 243l
0 > AR A BRI E - R B ey S e BB R B — DR A -
A ERETRE = (GEE > DL formats gI#5< (subcommand ) ‘B S AEHIRE S
A AIEA -

REEEEBEATT ¢
| GET SAS DATA='c:\srda.sas7bdat
- /[FORMATS ='c:\formats.sas7bcat'.
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2~ MEZMEH ([ERDL SAS HRME R Bl

FHTHSIZ M > S0 -

@,‘F stda sav [ETE3EL] - IBM SPSS Statizhics Data Edifor

wEE REE WA BEED RO Sl HEEtEG

RS (M) b |y E & %

el 3

RS EHIE(E) » BE D’$ﬁ .
&) FEEFERND).. - . .
- 1 o 3
| 2 0 &4

ST (). 2 0 i

ELBEEIN SAS ot STATA ZERMRUA » EFTRETE - MEH! SAS ORI
E/j = rﬁﬂ‘%{ﬁ@uﬂfﬁﬁﬁ.sas %%J ’ Eﬂa~{#%§$ proc format 3%%1‘;% s
(ERERLZ B -

R4 44 {8 (275 44 18) 8t - | ey, |
WEEH : ‘srda.sas?hdat | [ﬁ
-]

EETFAER - ‘SAS ¥7-8 Windows ES#H (*.sas7Thdat)

[/ By
O ERBA(H)

S EE TR sas WR(E)

FERREBHEATT ¢
* SAVE TRANSLATE OUTFILE="c:\srda.sas7bdat'
- [TYPE=SAS

/VERSION=7

[PLATFORM=WINDOWS

IMAP

/REPLACE

IVALFILE="c:\srda.sas".
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(=) STATA BREERE A KHEH SAS Transport §& ~ SPSS &l

STATA f1effk SAS Transport fi (*.xpt) MEAERMEH] > SEAEESZIR SAS Bkt
fig (41 *.sas7hdat') HYZFEHY > usesas 5 BRI Z22E SAS BRERHYERSE T4 Al
5 B SPSS R SCIRTRSY > BEFH usespss FHS AT EEEBTTHES - th AT
SMEER RS T BN E ] BT STATA [ A SPSS &M » (MBS /i
BRI - ARSI SR - HRT/RESRIE I ThRE -

1~ SAS Transport f& (*.xpt) MEAJHEH

B T E%# F File > Import/Export > SAS XPORT -

5% 2 - StatasSE 12.1 - [Resulis]

Edit Data  Graphics  Statistice  User  Window  Help
5 Open.. Cl+0 5 2% ] 3
: '}(
View... I— o o
= I Y S S A N S
Do... Statistics/Data Analysis
Filename. ..
Change Working Directory.. Special Edirion
Log »
Lmpoit ’ Excel spreadsheet (% xdss* sdssd)
Export r Text data created by a spreadsheet
(= Print 3 Text data in fived format
Example Datasets. . Text data in fixed formeat with a dictionsoy
Fecent Datasets » Tnformatted text data
Exit BAZ HPORT
Haver Analtics databasze
ODBC data source
HML data
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WEEAFRFEEHURE 2 » #5116 SAS R AR T] A Options )33 2% formats.xpf
fig > DURE R BERRAIE A - HE H R S R R I B ERR A R 7% formats. xpf
fi B SAS FEAAE -

B fdanse - Import FDA data (SAS ZPORT) =3

Filenanme:
|C:".$rda.:-:1:ut |[ Browss.. ]

Ciptiomns
[ ] Replace data in memory

I gnore accompanying "formats xpf" file if it exists

HEEHS BT -

fdause "c:\srda.xpt", novallabels

fdasave "c:\srda.xpt", rename vallabfile (both)

~ SPSS fi# (*.sav) MEA

FIH ssc ¥E<2edE usespss fiikH (module) - E5EA Command i &5
A ssc install usespss » ZZEESERK % FENIESYIBEES usespss 251% - Ba] Rk
LM A SPSS ## -

FEEEBEUIT
- ssc install usespss
- usespss using "c:\ srda.sav"
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= EAN/EH "HXFHE, & "Excel 18, IhEE

TR SO - WIRS VR IR - RS2 BRI « AT
IR AR AR SOOI 5 TTBCHEZDRMIR AR - 15003 LI DAY
S Excel i » [RIHG 13 = ER S S MAHRSCHRA SO0 B Excel fAUBEA B

MEH - DUNZ bt -

(—) SASEEA/MEH: "FiSCFHE ) B " Excel #
1~ WESCTREMEA/NE iR TR MER > EABRMELER - KEZEREA

AER TR

SSEL PSR (Comma Separated Values  (*.csv))

Tab 43f@fE (Tab Delimited File (*.txt))

HAh=E e/ FErE (Delimited File (*.dat))

AZ AR s SRR R R I BLE T B EER AR, R R 51T
BEFEAE S Z (LABEL » PROC FORMAT ) © 35 Fy [l % 5 B 307 i

(Fixed-Width Text File) » AIJfEER INFILE FEAGEII MG ERAEIELL INPUT
SE FAIEMINT -

[ #iEiz=ian
(= FARAE ...
BARAIC)

HHNED...
5 B

(= REEERy]
SR A
g ST AE..

Ty B H R

What twpe of data do vow wish to import?

Select a data sowrce from the list below.

Comma Separated Values (%o

Microsoft Exeel 9720005200252002 Waorkbook
Microzoft Exeel & or 95 Workboolk (* =5
Microsoft Excel 4 Spreadsheet (*.xds)

Microsoft Access 2000/200252003 Database
Microsoft Access 97 Databas
e Anrna Senarated W alies [0

dBAZE File (*dbf)
TMP File (* jmp)
Lotug 1-2-3 Spreadsheet (*wkl)
Lotus 1-2-3 Spreadsheet (* W)
Lotug 1-2-32 Spreadsheet (* k)
SPEE File (%)

Stata File (*.dta)

Paradox File (*db)
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e HE5E (Options) > 43FE77T ( Delimiter ) AJ3$##72 4365 ( Space)
B Character iy A FE T

TWhere do won want to save the file?

[CeTimited. dat | Brows.. |
TN i SAS Export: Delimited File Options X
Dielivndter
{:} Space
{1 Tah
() Character | Cancel
|

2 ~ SAS 9.2 B R 12 Microsoft Excel 2007 F[1 2010 FEEAE ZZ#8 =L (*.xIsx) »

VATV HF 30 SE M S 2 R BRI (Microsoft Excel 2008 1L
3k

TWhat twpe of data do wwon wish to impot?
Standard data zoumnce

Select a data source from the list below.

Micromoft Excel 97A2000/200252003 Warkbook
[ \tdicrosnft Excel 5 or 95 Workbook (7 =)
Microsoft Excel 4 Spreadsheet (¥ xds)

(=) SPSSEEAMEH M#liscFis B MExcel #
1 HISCTRETE AR TEIE PR > ST -

#3 FepEEE1 [ - IBM SPSS Statistics Data Editor
B%([E) REE) wWR0) SER0) BRI S

EWITEM)
3 I |
FREERE M) b Eﬂ E g % ﬂ
E5l5 b
FEEFIEB) 3

(&) SRS ERND).. var var val
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FEFHERI AT 73 R Tabsp it (*txt) ~ [EETRESCFHE (*.dat) ~ SR>
Bt (*.csv) SRS FRARR - RIBSCTHE AN EEZ D RE » HITA] 58
PRI -

THEAHE ¢ [srdacsy BEER(D)

TEFLRR 0 = et v *datr tosv) - Ay EZi&(P)

[ $FEEER b (LR EARZEIM) HLH

FHEH)

ek

HrpREE RS TR - AR T (Z201TRE—EEZE) > =
e LU AT AR — i ARBORIL AT 18 ESEIEBIGIINE - &
BR R B H A DA™ KA NG AR 2R - Rk IR ] DATA LIST
FILE GEEAEHE RIS - DUF)E S Eti A s -

{ETEE EHRHARIUE - E—H2W0-

EBE (A BEaT » FERRIERRER—THREAREE - g [R5
AR EREMUE - MiRE (AT 1288 -

EEREEE ST T EEREHRNE -

EE MR B8aT  FERZSTHE A BUE - Bk TR 38 [RPRT ]

it -
- P....|....1||.:|...|....?I.:I...l....?l.j...|....Alu.:l...|....?I.:I...|....*lal.:l...l....?EI
1 | 31 2021910261 3 2 74000000001 35303225
2 3279 00000000100 40500 205000 2021929
3 33
4 34
[4 [*]

WEREEC): o (EAsEEe)  [EEATD

L WS IHIB SRR Cupf) o [ ETRRL R
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fEZME AR T RS2 TREZE > SO SRl or ks Tab S fRfd
(*.dat) - SEEIARE (*.csv) o [EE ASCIH (*.dat) » H] A2 SR
EABREI T - BISE &R -

RS 44 8 (3475 44 f8) 5l - | mmY. |
EEHE © |srda.csv [—]
s
BTFIER : SERAIE (.csv) ~ | [mwrzee
¥ S EEEAEHEE W)
[ e e o (E OB B s (4] =

2 ~ SPSS 16.0 kL Fi557#2 Microsoft Excel 2007 ~ 2010 ( *.xls, *.xlIsx, *.xIsm)
R FEAKIIE H -

(=) STATAREAMEH! "#SCFHE ) e T Excel #

T EA# T File > Import » £ ZF5RK Py Excel (*.xls, *.xlsx) ~ 43
FEFFaRSCTAE (HENHIERERTIR ~ Tab ~ (28 ~ HEIFIHb) ~ BER
A SEAUE B SR R WTHE A - STATA 12.0 kDL F-Br4632 4% Excel
RV HE A BELIE H -

18




it 9 - StatalSE 121 - [Resuliz]

Edit Dats Crephics Statisics  User  Window  Help

5 Open.. Culb0 B 23 | £)

_I'J. 'x
v Y /o
LEW... F A Y S B Y )
Da... Statistics/Data Analys
Filename. ..
Change Working Directory... Special Edition
Log 3
Impout » Excel spreadsheet (*=ls* xdsx)
Export * Text dats created by o spresdsheet

(™= Print 3 Text data 1n fired format

Delimiter

() Automatically determine delimiter

() Comma-delimited data
() Tser-specified delimiter

[ ]

ARDEIAS SRR - RS Ry Raw Files (*.raw ) » FE{E2EHUE
IR FHIEHTERL - TRl BRI -

a8 | v [(EEo
gt R Raw Files (* raw) w B

Faw Files (* raw)

Te:d Fﬂ.ES *

] T L SR AR ME A RF R S 1T STATA dictionary fi#l 117 1€ F 1%
(*.dct) BfA Specifications F—H A XA TEMIN E FEHFEM -

19



(3 e dictionary file:

Examples
rate 1-4 speed 6-7 acc 9-11
2 linez 1:4d 1-6 st name 7-36 2:age 1-2 e 4

STATA [ (I ES bRt =TEDRE v 2058 - BEHE T BITIRIBTR KEE - H
th A EIEEERR AR - 7R NE (NI RC S A D A R R BA
A 48 T8 DL B {E B ) ( Output numeric values  ( not labels ) of labeled
variables) » [z RIIISUEFBAR AR GER NEFTR) -

[ 1D not write wariable names on the first line

[w]Eutput numertc values (ot iabels) of Tabeled variables

[] Do not enclose strings in dovble guotes

A E C D E
1 id stime al Az a3
2 3 2021910 2 61 3
3 19 2021925 9 21 10
4 42 2021946 2 6l 3
5 91 2022000 2 59 3
==
R gUl
& E C D E
1 id stirne al A2 a3
2 3 2021910 i 61| Ed
3 19 2021925 9 2l =88
4 42 2021946 L4 R
5 Ql 2022000 it SolaE
I Rz ]
I
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M ~ {EH Stat/Transfer st ENREHAENEE

Stat/Transfer FESFTRESCIRAVBIBE R RS R L » HELEREYENIEID /T
THIERE » #HRE EAMBRGEE ELPGE - Fris i 2R A e RS - 7l b EEHeft 7
VU ASEEE (Transfer ~ Variables ~ Observations J: Options) » EAHRTIREELER{EERE
L) Stat/Transfer 10 fl433mal -

(—) ®EHa (Transfer) g€

FrRk Stat/Transfer #kfigfs » [ ARSZSEEY (Input File Type) HZ ks R A
fJ Excel ~ SAS/SPSS/STATA & e Bil r] #E AR 2 » W AEAR 21 & (File Specification)
FR SRS A AR S 4T -

Transfer | “ariables | Observations | Options | Run Program | Log About

Input File Type: SAS hd

ASCIText - Stat/Transfer Schema -
dBASE or Compatible

File Specification: Epi Info v || Browse

p Epiln
FoxPro

Gauss

JMP - Yersion 3
JMP - Yersions 4+
LIMDEP

Matlab

Mineset

Minitab

MNLOGIT

ODBC Data Source
OSIRIS

Paradox

File Specification: Quattro Pro ~ || Browse
R WorksEace

SAS for Unix

SAS CPORT

SAS Transport
5-PLUS

SPSES Data File
SPSE Portable File

Stata Exit
Statistica - Version 5 Z
Statistica - Version 7+

SYSTAT
Triple 5 v

Output File Type:

BRI A% 2 (Output File Type ) thiBhsse » #4230 fg$EExcel 97-2003,2007
SAS/SPSS/STATAE ¥ s A2 =M (& ASCI) &5 » Bt =/ & (File Specification)
FEERE R S M - AHRR B E B ook - # K T Transfer | RIEfTREZS .2 1
Eé o
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(=) #15 (Variables) € :

i i HH o UAREHAS o3 480 > TR T Variables | o7 TIAY 7o fHI A8 T B A g 322
=iAE Quick Variable Selector Hhigy AR LUEREERG ) — 452 Keep 5 Drop-
ifii Target Type 3 Fy THEY » 55 0 F8)H 1T SCREIVINEL LU B M > 7R 0T Quick
Type Changer iy A SIEA T (LUEBGENG ) SRR - nIPussE -

Transfer| “atiables | Ohservations | Options | Run Pragram | Lag | Abaout

“ariable names “ariable Label

- = | |[EF

¥ stime

v

v a2 . .

vl a3 Target Type Quick Variable Selectar

v ad

aE-=) |

v/ b1 OB

v b2 1 yte

= h2:2 2 [ Keep ] [ Drop ] [ GoTo
O int

“alue labels for [a1] Quick Type Changer

1=5 O Long
=i
@ Float
O Double

(=) B {H (Observations) &X5E :

ARG IESIREZ R ATA RIS » {545 T )7 Where —Hirh > Wl AZ: B J7H9$E
L HEE ] HETT Missing Values pREH K i SHEE AR (simple random sampling ) ~
EEEAREE A (random sampling of fixed size ) FT&EEHHEE (systematic sampling )
—TEFERSRIARIIRE -

il

Ahout

Missing Values &)1
g stime

fou can test to see that any variable is missing by comparing it to the special, al

internal variable, '_missing’. For example ad

where income != missing Zi

Selecting Cases E?
Sampling Functions !
Three functions are available for sampling. < | b2 3

where

22



(P9) 3®IF (Options) E :

HIEFCERE M - HIMRFEAE L - #wis ~ &FHE (ODBC/ACCESS) ~ #iS
=F& (ASCII/Text File) -~ SAS ~ Excel T.ff% (worksheet) ~ JMP ~ R F1 SPLUS -
DUBedar 3885 (Output Options ) 55 19 {lEZ%E » 3l K LATHELE (Default) {5 R[S -

Transfer | “ariables | Observations un Program | Log About

Ayailable Options

General Options General Options
User-Missing Values
Date/Time Formats - Reading
Date/Time Formats - Writing [¥ivrite new, numeric variable names (vn)
Encoding Options
QDBC/Access Options
ASCIText File Read Use doubles
ASCIText File Write

SAS Walue Labels - Reading

[¥] Ask permissians before ovenariting files

Preserve value label tags and sets

SAS Value Labels - Writing Seed for sampling functions: | auto
YWorksheets
JMP Options Wariable narme case conversions

R and SPLUS Options
Qutput Options (1)

For case-insensitive programs:
Qutput Options (2} prog Preserve always hd
Uzer Interface Options
Data Yiewer Options . For case-sensitive programs: | Preserve if mixed case hd
Stat/Transfer Program Generation
Automatic Transfer Logging
[ Restore Default ] [ Restore Saved ] [ Save ] [ Help ]

FHETE R E £ B HE A R I B 0 YRR BEE B T RE - st an R - fEfEA
STATA BRI » [RIHR ST ek 5B iR =N A B RIGHT AR 2RO RTRE - B e E
IR - AEREARZRE » B Options 14 Output Options (1) » A Stata Version 325
FrfehiA » JRATHE T Save A E fETF -

Cutput Options (1)
=85 Data Hepresentation

WINDOWS 32 - Windows 32-bit b

Stata Wersion: |%ersion 8 v
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SHAN—HEAY - BRI SR ME Y, (ASCIHI/Text File Write ) 11 T Preserve input
widths | #¢5E » 1F Stat/Transfer 10 pix IR EME 28 HEE - HRTIERENE DI R
FE R AR TR i IMERIRE S » (AR I R P E IR R -

ASCIText File Write

Generated Programs and Schemas

[“]*yrite complete paths

[ Sharten names and labels for older versions
[“|Preserve input widths:

SR - FEBIRETR " ad FTEISARIRL | B - 1 SPSS ZORH TR E
ORISR By 2 -

| z@ | mn == o &5 @ |[1=we
al gm0 0 0.2, |2="B
a2 mEm 2 0 EASESE_ @7 (98.Em).. [0 ee
a3 weEm 2 0 AMEMAEEE. (8. | oo

5= "B (W8 "
a4 s (2 )0 sERSERvEERR. b= "FE

98 ="{EE"

2P RIEE H 1~6 - #ERR Stat/Transfer 4)3% © Preserve input widths | 2%
T (R AR A B R T 1, o RIS R IV & -

5~ #ERE

HEE H B e R IRy AR BN MK RE R - P SR AR SRR B R iz
SEE 0 MR T IR AR E AR HHDRESK Stat/Transfer fcfie THAEH] -
ek B Ca R R R AR 720 iR B AT i 2 AIRRE -

2ERH

IBM SPSS Statistics 20 Core System User’s
Guide http://library.uvm.edu/services/statistics/SPSS20Manuals/IBM_SPSS _Statistics
Core_System_User Guide.pdf

Sergiy Radyakin 2008 Using SPSS files in
Stata http://www.stata.com/meeting/snasug08/radyakin_usespss.ppt
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(—) Mg & (Z4FH)
1. BRSMNARLTIF SR U A A
2. BRIMARAT R E i s HARATHEN 5
3. BURHEIE TSR A S
4. 1B EEREE LT T BT ET SRR R E | 28 ABEEAI A -

(=) g g ()
1. EPSMARTAHBEARAEARERE ~ iR LI 5E
2. BRSMARLZHIFE TSR A &
3. BIRSMARLZ A BRI SE B A &
4. BURFHSIITTEBIBA A -
LA EREL— e BE - OIS LEAE - ATLMEZHEE =R -

(=) BENEE&
thRTFEBE TR A &

(1Y) e &
ANREAEZAEA

— MABR

HEAEREMEEERR IR - 200 A S EHE R UICEERE
SEEEE T B ERS AR T 5']%&%%%%’3;51%?&“ EW A FRR R B4 LUR R R
KA TERE - K EIEEEFETER, (8 R ARLEE ~ [ E SR E T
REB RS Email 255 B E AR Huls -

B R - FENERKEES - 1l (FE2) U -
W R BES R B = TER -
B EKEER  (02) 2787-1829 ; {HEL : (02) 2788-1740 5 Skype : csr_209 o

= BIRTE

(—) —#e&r & - KIRHE ANERBAER S 57 - HIRS F—F MR - & B30
B2 AT > NGRS - B E g BRSSPI E R ERIEREE - & BEN
IR A SR 2EE > SRR HE R ERER -

(=) BEAE & - i AR ERERESEEREESR - Rt e ifseleE #0413
FERIICHERD - = T g B ERRRIESE | R PR iR S A
ARG RHE L S - RS RHER AR 11 H LUE FEMEROIEE R - BEG e
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EHERRAA -
(=) WM& R HE NEE RIS RE T B A s e 5 0 —
kel B e Be s B TEIIAREI TR RIE - R A -

m - BRERER

BiREER | BUTREER IR SRDA:Nesstar §§ L-53#7

Zio) o | TR | BERR

AR | FERR | #HE | T&E =#H g2t | e

—fga | O O O - O O O O
FeeE & O O O O O O O O
HgEa | O - - - - O O —

b EEEH
FORHEEAESS S B A IR I - JRFR 2 T il BMAVE R - XA —255%
AT EBEE > SR RS ETT -

(—) ERGER © eSS & BRERK ) FRERE -

(=) HHEEM @B THEAEA®R > BROFRE LS SereitEH&
Fr SR ASE R T I 25 < - A Re iR R 2SO E R EGH -

(=) BRME  stEE R —FRNEAEE - AERHEHRSE T TR RS
WEEHE - DUFRERE Rk SGEN 2 -

L HHE R

RERHHINECH S 2 SR &R} | RS eSS E b i i
KB - RERHE TIEA B HEB R Wl ZESRECH - &l
HENWER LR LERE TRE T EER » QFIRRT  BMTE e EE
FH B S ERERR IR - WIS TR RS AN R B A PSR BE A -
KRB R AR B R LU IR HE -

SE] AEREY B A TR ORI AR

BORHEE B AR AR A R s

TR A TR

TEEEORE FHE A HaR R R AT AR -
TSRS IAEORNG T SRR A TR | SR BN B (R SER
Bolas " RPERGR AR R L B > FRPTRERAOR RS -

AN ¢ (02) 27871824 > FRHHAHRERIGELE -

A w PR

26



. | B E

"TERER AT SOk o AR ) Ry TR R FERE ATt e R B FE L A AR
FEEET LR DIRB S S TP > B =H ~ NH ~ LA R HEFTE A
BT o AU TR IIASERNA R Z 2R R et B 0 AL Bl o EGHEE SR AL
REFTTE DL MAHRREE . S -

v ZFERAHE AT
v BREE R B R
v BIASNE R A
v BRI SRS . B
v TR A

T E RS OB L OS5 - RE LA e-mail A5 =0 Ra T > i
L1 1000-1500 Ryl » WLV 5Eki < PR - AhRiimiE 2= B &R B E T
BT > — SRR ENGS - /9T 750 JC - B FIERA > ATIHREEEHEM
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